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.. Nebraska’s Commercial Energy
.. Code: The 2018 IECC
COMcheck Basics

... Nebraska Energy Code Training Program
.. Instructor: Matt Belcher

. December 7, 2022: 10:00 a.m. - 11:30 a.m. CST
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Housekeeping

« Aftfendees are muted upon enftry
* Enter questions in the chat box
* This training Is being recorded

« Slides and recording will be emailed to attendees and
posted on the MEEA website

« CEUs are provided (ICC and AlA)

« Email Corie at canderson@mwalliance.org with any
guestions
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mailto:canderson@mwalliance.org

About MEEA

 MEEA is a nonprofit membership
organization with 160+ members,
iIncluding:
« Utilities
« Research institutions
« State and local governments
« Energy efficiency-related businesses

 MEEA helps stakeholders understand
and implement cost-effective
energy efficiency strategies

Good Life. Great Resources.
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About the Nebraska Training Program

. « Goal: prepare the Nebraska workforce for upcoming
. changes in construction best practices

« Residential and Commercial Energy Code
 Building Science

.. * Practical Solutions

« Focused on providing training to builders, code officials,
. design professionals, public officials and students

* For more information, visit:
hitps.// www.mwallignce.org/nebraska-energy-codes-
raining-program
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https://www.mwalliance.org/nebraska-energy-codes-training-program
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VERDATEK

SOLUTIONS

About Matit/Verdatek Solutions

« 40+ Years in the Building Industry

Served as a Top Building Codes official in the St. Louis area.
Director of University of Missouri Columbia High Performance
Buildings Research Center. Created and Instructed
Curriculum for Students and Industry Professionals.

Currently Assisting University of Missouri Science & Technology
iIn Building and Energy Code Curriculum and Policy

ICC Member serving on 2012, 2015, 2018 and 2024 Energy
Code Development Committee. 2021 Building Code-
General Committee

NAHB-Approved Instructor for Advanced Building Science
and Advanced Business Management
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. \ﬂl‘/COMcheck Learning Objectives:

. Basics of using the COMcheck software, reviewing generated
compliance reports and the latest and greatest new features.

1. Obtain an overview of the basic functions and how COMcheck
calculates compliance for the building envelope, interior and
exterior lighting.

. Be able 1o identify the construction specifications needed to
complete a compliance calculation in the software.

. Learn how to enter the building envelope, lighting, and mechanical
components into the software.

. Understand how the compliance reports are created and what they
entail.

NEBRASKA

CODE OFFICIALS

ASSOCIATION

P
ASKA
MEEA NEBRASKA
~ EEme

MIDWEST ENERGY EFFICIENCY ALLIANCE GOOd L‘fe‘ Great ReSOU!’CeS‘

INTERNATIONAL
EEEEEEEEEEEEEEEEEEEEEEEEEEE CODE COUNCIL




States that allow COMcheck
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As of September 2015
B CanuseCOMCheck [] COMcheck Not Applicable = er

O Applicable By CountylJurisdiction




Commercial Compliance Tools

Desktop Software Tools Ffe
I! \/ I Web-Based Tools

COMcheck” &/
\
CO _bJ

Mcheck-We
Compliance Guides

f'-l ] COMcheck™ Prescriptive Tables

Package Generator .
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I'n_p]‘/COMCheck |'n\_p]/ COMcheck-Web

COMcheck-Web simplifies commercial and high-
rise residential energy code compliance.

It performs just like COMcheck, the desktop version,
but you don't need to download or install any
software on your computer.

« Can exchange files between desktop and web
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http://www.energycodes.gov/comcheck/

COMcheck/COMcheck Web

« The COMcheck software product group makes it easy 1o
determine whether new commercial or high-rise
residential buildings, additions and alterations meet the
requirements of the IECC and ASHRAE Standard 20.1.

. « COMcheck also simplifies compliance for building

officials, plan checkers and inspectors by allowing them
to quickly determine if a building project meets the
code.
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Commercial Buildings in the IECC

.. Under the Purview of the Commercial Code
.. v Buildings with commercial use

v Multifamily residential buildings four stories or
greater in height

.. Not Under the Purview of the Commercial Code
.. x  One- and two-family residential

. x R-2, R-3, R-4 three stories or less in height
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What About Mixed Use? - C101.4.1

« Treat the residential bullding
porfion under the applicable

. residential code
« Treat the commercial building

porfion under the commercial
code

. « Code Official has final authority

Good Life. Great Resources.
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Commercial Compliance Options

. 2018 IECC - Prescriptive

v’ C402 - Envelope
v' C403 - Mechanical

. ASHRAE 90.1-2016 v C404 - SWH _
. _ v C405 - Lighting 2018 IECC — Performance

: _ » C407 - Total Building
AND Pick at Least One C406: Performance

@IR QC406.2 — Eff. HVAC Performance « C402.5 - Air Leakage

0 C406.3 - Reduced Lighting Power ) C4O?’_. Mandatory Mechanical
Provisions

0 C406.4 - Enhanced Lighting « C404 — SWH

Controls

QC406.5 — On-site Supply of
Renewable Energy

QC406.6 — Dedicated Outdoor Air
System

L C406.7 — High Eff. Service Water
Heating

L C406.8 - Enhanced Envelope
Performance

0 C406.9 — Reduced Air Infiltration

« C405 - Lighting

* Building energy cost to be <
85% of standard reference
design building




.Asuﬁs\ 90.1 Simplified Approach Option for
HVAC Systems

The simplified approach is an optional path for buildings that
meet these criteria:

« Building is two stories or fewer in
height.

« Gross floor area is less than
25,000 sq. ft.

« System serving single HVAC
Zzone

« Each HVAC system in the
building must comply with all 19
requirements.
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COMcheck: Who May Submit?

 The commercial energy code requires that a registered professional
submit compliance documentation (construction documents and
compliance verification).

In the IECC, Section C103.1 Construction Documents, General, the
wording states that construction documentation and other supporting
data shall be submitted in one or more sets with each application for a
permit.

The construction documents shall be prepared by a registered design
professional where required by the statutes of the jurisdiction in which
the project is 1o be constructed. Where special conditions exist, the
code official is authorized to require necessary construction documents
to be prepared by aregistered design professional.
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Landing Page

!"I“/ COMcheckeWeb

‘ o New Project ‘

PROJECT

Code/Location

Code: | 2009 IECC v|

State: \Alahama V|

City: | Abbavill v|

If your location is not included here, choase a nearby
location with similar weather conditions.

Project Type

® New Construction ) Addition () Alterations

Project Details (optional)

This information will appear on the Edit Project Details...

compliance repart.

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

¢

Project ftl ] frai Address | | Password | | WbLogln

2008 [FCC Register () | Forgotten Password?
INT, LIGHTING | EXT.LIGHTING | MECHANICAL B s | - Y
Building Envelope and Interior Lighting Areas BR=SG g NS
| Add Building Area ‘ ‘ o Duplicate ‘ | X Delete |
Building Area Area Description Space Conditioning Area Wit

n Select Area Cateqory... v
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— = Commercial Buildings

Building System Compliance Options

Prescriptive
Option
Envelope
Mandatory
- . Provisions Trade Off E nergy_ COde
Sigatins (required for all Option Compliance
compliance options)
Mechanical Total Building
! Performance
HVAC
|
SWH
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Mandatory Requirements Include:

« Air Leakage

 Air barriers

« Fenestration air leakage

« Rooms Containing Fuel-burning Appliances

« Air intakes, exhaust openings, stairways and shafts
» Loading dock weather seals

» Vestibules

« Recessed lighting

« Commissioning

Good Life. Great Resources.
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What is COMcheck??

> Envelope
«» trade-off calculations are based on envelope loads only
» defines a proposed design and a budget design

> Lighting
«» Watts/square foot (LPDs)

> Mechanical

» short wizard to customize a list of requirements applicable to the
system identified
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Envelope Trade-Off Methods:

»ASHRAE 90.1 (Pre-2013) Normative Appendix C Methodology for
Building Envelope Trade-Off Option

« 90.1-2007/2010
« 2009/2012 IECC

»ASHRAE 90.1-2013 Appendix C has limited performance method
(EnergyPlus) (New)

»2015 [IECC Component Performance Alternative (Total UA) (New)
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Project Types:

* New Construction: Trade-off compliance method

 Alteration Prescriptive compliance

&‘ MIDWEST ENERGY EFFICIENCY ALLIANCE

g. « Addition Trade-off compliance method

NEBRASKA
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Commercial Building Envelope Requirements

> Mandatory Requirements:
» Moisture Control
o Air Leakage

» Climate Specific
Requirements:

» Roof

« Above Grade Walls
«» Below Grade Walls
» Floor

«» Slab

» Skylights, Windows, and
Doors

CODE OFFICIALS
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. Mechanical and Service Hot Water

g. Requirements

.  Efficiency requirements

. « ECOnomizer requirements
.  Fan Power Limitation

..  Mandatory requirements

.  No compliance metric available
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Lighting Requirements

 Mandatory requirements: Controls, Switching
e Interior/Exterior lighting power requirements

Complies if total connected power <= lighting power

allowance
|’n_p]‘/ COMcheck

NEBRASKA

Good Life. Great Resources.
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When do Lighting and Power Requirements
Apply?

« Original Installed Lighting System in a New Building, Addition, or Tenant
Build-out

« Existing Lighting System that is Altered
« Change in Occupancy that Increases Energy
« Change in Occupancy that requires less LPD as shown in the LPD tables

Exceptions:

« Alterations where less than 10% of the luminaires in a space are
replaced and installed interior power lighting is not inCreased

« Lighting within dwelling units
 Where 2 75% of permanently installed fixtures (except low-
voltage) are fitted for and include high-efficacy lamps

NEBRASKA

Good Life. Great Resources.
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. Electrical Lighting and Power Systems

.. Requirements

* Mandatory Interior Lighting requirements
* Required Controls
« Wattage/Efficiency Limits
Interior Lighting Power Allowances (watts/ft?)

Exterior Lighting Controls
* Required Controls
« Lamp Efficiency
Exterior Lighting Power Allowances (watts/ft?)

Dwelling Electric Meters

Electrical Transformers and Motors

« Vertical and Horizontal Transportation Systems and
Equipment
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Landing Page

. " Project ffle fral Address | [ Pessword | | B Logh
COMcheck-Web “
2009 IECC Register (g | Forgotten Password?
. ‘w‘ PROJECT INT LIGHTING | EXT, LIGHTING | MECHANICAL B pepons Y

Coae/Location Building Envelope and Interior Lighting Areas [34C (IR TF:RE
Code: | 2009 IECC v|
‘ Add Building Area ‘ ‘ = Duplicate ‘ | X Delate ‘
State: | Alabama v|
City: ‘ Abbeville v ‘ Building Area Area Description Space Conditioning Area s
If your location is not included here, choose a nearby .
location with similar weather conditions. n Select Area Catemw'“ M
Project Type
® New Construction () Addition () Alerations
Project Details (optional) b
This information will appear on the Edit Project Details..
compliance repart.

ASSOCIATION
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@i Untitled.cck - COMcheck
Fle Edit WView Options Rt Help

[ ™ | ¥ Wy
Project Envelope
Location

State Pennsylvar
City Abbottstow

Project Type

) New Constr

Space Conditioning

() Nonresidential

90.1 ('89) Code
90.1 ("99) Standard

Code: Standard 90.1-2004

90.1 (2001) Standard cal

1998 IECC
2000 IECC
2001 1IECC
2003 JIECC
Georgia
Massachusetts
Minnesota
New York

Yermont
J Kesiaenual

Area Category (Space-By-Space)

[ Add Category ] Only add Areas with lighting alterations

J Area

Category

90.1 (2004) Standard

l

Project Details {(optional)

7

This information will appear
on the compiance certficate.

[ ‘W Progect Details. ..

J

TitlesSite/F it

Altera Expand the Screen

() Semiheated

Let’s take a closer
look at this area.

like other programs.

Asea ! w2 |

|
|

Envelope T8D

Lighting

TBD

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE
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COMcheck Basics

« COMcheck is a reflection of the difference between a
'design’ building energy performance factor (EPF) and @
‘code’ or budget building EPF.

* The methodology used to determine EPF is provided in
ASHRAE 90.1 Normative Appendix C: Methodology for
Building Envelope Trade-off Option.

NEBRASKA
Good Life. Great Resources.

$ MIDWEST ENERGY EFFICIENCY ALLIANCE
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. COMcheck Project Specification

.. Steps

* Project

.. - Building Envelope Components
e Lighting

.. e Mechanical

. » Requirements/ View/Print/ Save

NEBRASKA
\\\\\\\\\\\\\\\\
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Information You will need:

.. * Energy Code

» Builder and project location

» Area take-offs for envelope assemblies

* Insulation R-values, fenestration performance dato
* Lighting fixture details

« Heating and cooling system details

» Service water heating details
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Landing Page

{,4*‘/ COMcheck-Web

‘ o New Project ‘

PROJECT

Code/Location

Code: | 2009 [ECC v|

State: | Alabama v

City: | Abbeville vl

If your location is not included here, choose a nearby
location with similar weather conditions.

Project Type
® New Construction () Addition O Alterations
Project Details (optional)

This information will appear on the
compliance report.

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

¢

Edit Project Details...

Project title

2009 |ECC

INT. LIGHTING

EXT, LIGHTING

) Email Address ‘ |:':":"""-"I'I" | ‘ﬂ

Register &) | Forgotten Password?

|E Reports Z‘

@J

MECHANICAL

Building Envelope and Interior Lighting Areas WS 0@RG LT RS

| Add Building Area |

‘ - Duplicate | | )( Delete ‘

Building Area

n Select Area Category...

NEBRASKA

Good Life. Great Resources.
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NEBRASKA
CODE OFFICIALS

ASSOCIATION

INTERNATIONAL
CODE COUNCIE

32



@i Untitled.cck - COMcheck

Code: Standard 90.1-2004

File Edit View Options EseS5 [a
: 90.1 ('89) Code
D @ £ w0 oo
. e, 4 Title Bar
Project Envelope 90.1 (2001) SEX -al
Location v 90.1 (2004) Standard P! Menu Bar
2000 JECC et Toolbar
s TitlesSits
2003 IECC Make sure the
Project Type Georgia correct code is
O New Constr  Massachusetts Alterations chosen
Minnesota
Space Conditioning | New York Qwne A
Yermont
(& Nonresidentialr (U rResaenual () Semiheated
Area Category (Space-By-Space)
ner r r
| AddCategory | Only add Areas with lighting alterations
] Area Category Asea J W/It2]
i |
1 [Cick to select category. R | |
Notes

Envelope

| Edk Project Details... |

TBD Lighting TBD

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE
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nvelope Requirements

TSR s — I __ _ _
T T e Samgre.<ch - - COMg ek 3.5.0. L Code. 2003 £CC
i -y = | : "m W > = a8
segect Efrvetope —  ArferOr Lagbaireg [ — [ ———
T Rcot T akoymgnt T ot Walt [T —re— Doar Baserrwrst Phoor
~ 'I..'"" Cumrw =t aows '.'.\;.l" h‘ “.‘.‘ .“--.‘.‘... >~; ﬂ-v-- -—e-
Convgaeow 1 sevwine - - - - fmw -~ - U Fartme E
= i 4 Cetes Perseowai e ” ‘\".o L \\'osv T acow
Saxsrg !
& Ract L Friadiinewy Erdwaty A ’! lll)"‘l "2 2% 0 .08
2 -. l’mmlm-h‘i 327 ~fweedan [h-nm [ ).:xo ”r 3 oo | &28> | =1
\_ A2 oww 1 Wood - 'ramed 14 oc _Claneg .. e | is2 "I : L S.5%0 oS 1.4%
- ndoew 2 | Waood-Framed, 247 0 < | [ Clarnimg | 32 na | 2.9 03s o. 00
> adow 3 | Steel-Framed 16" o C c_unsg -. - " 1 .50 O3S 145
(8 Docs ) ! Sieel-Framed 248" o e k] e | 7S "na . 1089
7 Door 2 ! ﬂ\ol“: Boildemg Wadl _hw—:vw ~1 162 n2 ».130 |
> Deor 3 Sobd Concrete - - — . = > 13¢
s —o—— &, Solid Grouted oo
-
— Othe- ul_ Facior Op!»:-- B> &7, Pamabdy Crouied, CTells Empty -
e ' &, Parmaby Crouted, Cells insulaned
&",. Unreinforced, Cells Ermpty
&, Unreinforced, Cells insulates
£, Sadid Crouted
£, Pamaly Crouted, Cells Empry
£, Partalby Crouted, Cells nsulaned
5" Unreinforced, Cells Empty
£°. Unreinforced, Cells Insulated
107, Salid Crautea
107, Partaly Crowted, Cells Ermpey
107, Partsaly Corowted, Ceolly nsulated
10°. Unremnforced, Cells Empty
107, Unreinforced,. Cells Insulated
127 Sold Craouted
12" Partualby Crowned, Cells Ermgpey
127 Parvalby Crowted, Cells insulated
127 Unreinforced, Celis Emmpty
127 _ Unreinforced, Cells Insuiatea
Ersveilope FASSES Deasgpe IX Detar thar Codhe Ervvw oo e = b terer Lghteg THRD Exsemce Lighteg TR 3—3
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U/A Trade-Off Compliance

Corrphance Passes 3 UA trade off

Camgiance. 12.2% Better Than Code Masorruen UA. S00 Your UA 439
Tl At s e The T aam r0ee wPaan fem A e e T T e & S 0 e T -
T R T et w em B S @G s e R — -

Extence W Type A Steel Frarre, W o 1220 130 0 &
Window 2 Wood Frame Doutile Pare w Low-E 7 0.3 -
Docr B Sold 41 0420 17
Extencr Wil Type B: Sheel Frame, 18700 23513 130 s0 173
Wnoow 1 Wood Frame Doubile Parne vt Low-£ 210 0330 .=
Window 2 Wood Frame Doutie Pare v Low-E x 0330 10
Wndow 3 Wood Frame Doubile Parw wih Low-& S 0330 s
Door A Glass -4 0310 7
Roct Type 1 Sheel Jost T afer 8" 00270 823 o0 30 21
Window 4 - Saylght Metal Frame wih Thermal Breas Trple Pare = 0700 pr.
Window £ - Shytight Ceher @ 0 %40 8

Conplance Sistermert The proposed bulding desgn desarbed here 5 consstert with the budang lans. specfcatons, and other
oA O SubrmaBied wilh the Dermit Jppicaton The proposed Duldng has Deen desgied 10 mMeet he 2010 New York Energy Comenrvan

Corstructon Cooe regumements in REScheck Verson 4 4 1 and 10 comply wih the mandaiory "egurements 15300 n the RESoheck inspect
Checkist
Narmwe - Toe sy L ate
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= Envelope Screen

@ EZ - Casestudy.cck - COMcheck
File Edit View Options Code Help

Code: 2001 IECC

¢

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

Building Components are added by clicking on these.

NEBRASKA
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DT EH ¥ @B Xo= &
Project Envelope Lighting Mechanical
[ Roof J[_ Skylight J(_ Ext Wall ][ Int Wall J[_ Window J[_ Door J(_ Basement J(_ Floor )|
A Cavity C
Component\ Assembly Construptnon Gr Area Insulation |
Details
RValue
___|Building A B — | ] - !
1 Roof 1 ‘Non-Wood Joist/R 20532 ft2 | 190
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Windows — U-Factors

Table 102.3(1)

U-Value Default For Windows
Glazed Doors and Skylights

Fi Material arad Prochsct Ty Do sale=
e Y= Sangle
AMetad withan st thesraal el

Opevabie (rnchaing Sy eswd sy

Rercs timad 1.27 D87
Fooexd 1.13 D6
Garden Wasdow 26D 1.831
Castean Wall 1.2 D7
Shryfpiht 1.58 1.31
Site e semabier] Sinpserifovestsessd glecsy 1.36 D22
ket with theyraal breslc

Opevabie (rchaing Skding arwd sy

ghess dhomw)

Fooexd 1.08 D.&5
Garden Wesiow 1.07 D.a3
Casten Wall 1.1 D.GEB
Shyfight 1.89 1.1
Site g sevabied Siopesifovestsesad glecay 1.25 D.7D
Pp— P —— "

Opevabie (rchadng sdng end ssngeng gless
s D.50 D.57
Foxexd D58 D.S6
Shoyfaght= 1.75 1.05
Wiy iiTierpless

Opevabie (nchaing sl ared ssngey

pheass doaws) D25 D55
Foeed D58 D.5G
Geasden Wharsiowr a3 1.a
Skyfipght 1.497 D.B4

OMEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

NEBRASKA

Good Life. Great Resources.

DEPT. OF ENVIRONMENT AND ENERGY

Single Pane Double Pane Triple Pane
H U=10S MU=055 MU=037

>

A

NFRC tested and certified
or default window U-value
range

Use assembly U-value

All windows must meet or
exceed

NEBRASKA
OFFICIALS
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Overhang/Projection Factor (PF)

PF= A/B
PF=0.5
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Questions so far?

Please type in chat or unmute

NEBRASKA

Good Life. Great Resources.
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Interior Lighting Compliance

¢

Mandatory Interior
Requirements g Lighting Power
Requirements

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

Controls The building complies if its total connected power is
no greater than the interior lighting power allowance
Switchin » S
9 Total ormeeted Interior Lighting
Power Allowance
(805.4.2)
Entire Building
]

Partial Building
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—— Adding Lighting

& EZ - Casestudy.cck - COMcheck Code: 2001 IECC

File Edit View Options Code Help
D=3 ¥ B X = &

Project Envelope Lighting Mechanical

] T8/T12 Fluctescent || Compact Fluorescent |] HID “ Incandescent | Add Space

. - T Lamp Descrption/ Lamps Per Number of Foadure
Component I tuturelD Fucture Description Wattage Per L | Ballast Fodue \ Fobues Wattage
|1 |5 Space 1 | | | | |
2 . 5 ic Troff 148" T12 40w - M j ~ 4 ~ 174 138
= 1 Lighting components are N2 {Megnetic =i =] !
3 | P s Troffer |48 T12 40W SMagnetic = 2 =l = L=
a | added by clicking on these cTroffer |48~ T12 40 ~|Magnetic ~|| 2 | s | 70
'S | =TS TTZrorescem s © X2 ic Troffer 124" T12U 40W wiMagnetic ~|| 2  ~| 53 | 70
6 T8/ T12 Fluorescert 2 E 2 x 4 Prismatic Troffer |48~ T12 40W v | Magnetic : -
= : ‘ - = = I Lighting Results r

Allowed Wattage 28235 Proposed Wattage 31186

Envelope T8D Lighting

IUse the Options Menu to Arrange Lighting Fixtures by Spaces.
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. Functional Testing of Lighting Controls

.. Section C408.3.1

* Prior to passing final inspection, registered design
professional to provide evidence that lighting control
systems have been tested to ensure that control
hardware and software are calibrated, adjusted,
programmed and in proper working order per
construction documents and manufacturer’s installation
Instructions.
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Lighting Using Space-by-Space

Future
Bath- Development
Office A: 400 f2 Office A rooms
Office B: 850 ft2
Bathrooms: 350 ft? =
Corridor: 50 ft2 Corridor
Retail A: 500 f¢2 .
Retail B: 500 ft2 Retail A
Future: 350 2 Retail B
Office B
Total Building Area = 3000 £
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Mechanical Systems and SWH Commissioning
Section C408.2

* Prior to the final mechanical and plumbing sections, the
registered design professional or approved agency shalll
provide evidence of mechanical systems commissioning and
completion in accordance with section C408.2

« Mechanical Systems exempt from commissioning
requirements (all other systems must comply)

* In buildings where total mechanical equipment capacity is
< 480,000 Btu/h (40 tons) cooling capacity and < 600,000 Btu/h
combined service water heating and space-heating capacity
 Included in Section C403.3 that serve individual dwelling units and
sleeping units

44
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=—— - = Mechanical

Code: 2001 IECC

File Edit View Options Code Help
D EH £ @B XE&E &

Project | Envelope | Lighting €_ Mechanical
[ HVAC System || Plant || Water Heating

: E quipment Fuel T Condenser System
Component iy Capacity | o Type I Detads
! . | | : |
1 | weter Heating 1 = . | J Click here... -
2 | = HVAC System 4 | 1 ! ! | |
3! Rooftop Packaged Heat Py | Select e | [Select >l
4 | = HVAC System 1 . 1 | | . . ’
5| Rooftop Packaged Heat P | <85 kBtuh i || |Ar-Cooled  ~|| ;
6 | = HVAC System 2 [ @ ] | ‘ . i
72 | Rooftop Packaged Heat Py | <65 kBtu/h | |Ar-Cooled  ~|| |
8 | = HVAC System 3 . 2 . | | | |
9 | Rooftop Packaged Heat PU [»=90 - <135 k... w]|| Ar-Cooled  «|| Ajir Economizer -aef|

The Mechanical section generates a customized list of mandatory
requirements applicable to the mechanical components you identify.

Envelope TEeD Lighting 102

Use the View Menu to display Requirements
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@] EZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC
File Edit View Options Code Help

D&

HVAC System

HVAC Equipment Type

Heating Equipment Type: Cooling Equipment Type:
() None (*) None
| Building O Central Furnace O Field-Assembled DX System
. Water Heating 1 O Duct Fumace O Hydronic Coil
= HVAC stﬁem 4 O : St Coil
Rooftop YENENIC OF SOOI S 08 O Packaged Terminal DX Unit

O Heat Pump

n“

HVAC System 1
Rooftop Pac -

HVAC System 2 O Radiant Heater
Rooftop (O Unit Heater

HVAC System
Rooftop% O Other

(O Rooflop Package DX Unit
(O Split DX Systemn
() Other

' e

i

(0| w}m}mta wlw -
Hi

Zoning Category:

[ oK ] [ Cancel |

Envelope @ TBD Lighting @ -10%

IUse the View Menu to display Requirements.
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EHRH T |

Code: 2001 IECC

File Edit View Options Code Help

DEE ¥ W"m X & |
Component -u.m- Fuel Type/ Condenser System
Capacity Heat Sowce Type Detads
| Buiding :
1 | water Heating 1 2 { Chck here )
,_?“. = HVAC System 4 | 1 A - = "
.3 | ~ RooftopPackagedHeatPy | Sel
4 = HVAC System 1 1 ’ . ¥
. .+ = - - System Has a Ceculation Pump
S | Rooftop Packaged Heat Py ] - y
s | = HVAC System 2 7 1 [(] Heat Trace Tape Installed in the System
7 | Rooftop Packaged Heat Pu |<s - oK
O s = (] . ‘
(® | Rooftop Packaged Heat Py »= = LS || 7T Air Economizer
Envelope TBD Lighting @ -10= | I

Use the View Menu to display Requirements.
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Alteration Type Project:

»Projects involve changes to or replacement of
 Existing building components that are part of building envelope

« Lighting, heating, ventilating, air conditioning, and water-heating
equipment

»Specify only those envelope components, lighting fixtures, or mechanical
systems/equipment that will exist upon completion of the project

» Alteration detail dialogs
« Specify exemptions if applicable
« Additional qualifications may be required (e.g., Window/wall ratio)

»Compliance shown as Pass/Fail for Envelope and Lighting

M E EA NEBRASKA
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. Existing Buildings
.. Section C503 - Alterations

« Code applies to any new construction
. « Additions or new work in existing structures

.. « Unaltered portion(s) may not need to comply

« When complying via ASHRAE 90.1-2016,

. alterations do not need to comply with C402-
@

« Where existing building exceeds fenestration
. area limitations of Section C402.4.1 prior to

alteration, building is exempt from C402.4.1

.. provided there is no increase in fenestration
ared

Good Life. Great Resources.
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Existing Buildings
Section C503 - Alterations

« Heating and Cooling
 New HVAC systems and duct systems that are part of the alteration
to comply with Section C403
« Service hot water systems
 New SWH systems that are part of the alteration to comply with C404

* Lighting Systems
* New Lighting systems that are part of the alteration to comply with

C405

« Exception — alteration that replace <10% of the luminaires in a space
provided such alteration does not increase the installed interior lighting
power

NEBRASKA

Good Life. Great Resources.

INTERNATIONAL
CODE COUNCIL

$ MIDWEST ENERGY EFFICIENCY ALLIANCE

EEEEEEEEEEEEEEEEEEEEEEEEEEE

50



. Existing Buildings - Lighting Power and Systems
.. Section C502.2.6

(N:%%Iigh’ring systems installed as part of an addition o comply with

 Total interior lighting power to comply C405.3.2

« Stand alone addifion
« Addition + existing building as a single building
 Total exterior lighting power to comply C405.4.2
« Stand alone addition
« Addition + existing building as a single building
» Repairs — C504.2

« Repairs exempt where only the bulb, ballast or both within the existing
luminaires in a space are replaced, provided that the replacement does
not increase the installed interior lighting power
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Building Controls are Complicated

 Since 2004, about 30% of all new requirements have

been related to buillding controls

.. » Control requirements can be difficult to implement and
. verification is beyond the expertise of most building

.. code officials

« Assumption is that they are implemented and working
. correctly

.. Source: https://www.pnnl.gov/main/publications/external/technical reports/PNNL-

. 26348.pdf
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Mandatory Requirements in COMcheck Software

L\

> Requirements Checklist generated automatically based on input
« applicable code
« building location

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

L

Esvelope Compliance Ceortificate
2091 IECC

CORR e WL Tarsard Yarpom 10D Farwam 2

Oams Masame © WProgram FAe s e OO eck. B2

Sectian 1 Exejpect Bf crrnation

Air Leakage, Component Certification,
and Vapor Retarder Requirements:

All joints and penetrations are caulked,
gasketed, weather-stripped, or otherwise
sealed

Promecs  — COMscheck 0L
Cergrer™ e v e Adaavia
Do v et St s Aras

Sectian ? Cevoxal Bt carasion

Poddwy Lo |V Sealnir biin)
D Iows

Mesmiay Degree Days (v 45 Sagrees
Cotey Degred Days (baasx b Segeea )

AN Lessage, Compote st CorMTua™on asd Vajor KNetardey Sogqus ¢ wewty

I AR et Get gt i omd Gt AR S, SARTIS, WA PO, v RS ra ahed
] oy GUors el BV IR Cernted A8 @ 0he ) CEEARE T QU TER et

3 Compistm o st s B U Naisirs e d as cos Rea
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. Systems Commissioning and Completion

Requirements
Section C408

« Commissioning is critical to ensure
that buildings are working as
designed

* Preliminary and final reports
required

 Mechanical and lighting
commissioning detailed in section
C408

NEBRASKA

Good Life. Great Resources.
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Benefits of Commissioning

o

Improved

occupant comfort Increased

and satisfaction  building system life [I gpeet eSS
resulting in higher

productivity

Increase in the
assel and
expected rental
value associated

with a building, etc.
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. Functional Testing of Lighting Controls

.. Section C408.3.1

* Prior to passing final inspection, registered design
professional to provide evidence that lighting control
systems have been tested to ensure that control
hardware and software are calibrated, adjusted,
programmed and in proper working order per
construction documents and manufacturer’s installation
Instructions
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ompliance Certificate for Permi
COMcheck

COMcheck Software Version COMcheck-Web
Envelope Compliance Certificate

Project Information

Energy Code 2012 Ontario Building Code and Chapter 2 of Division 3 of SB-10(2017)
Project Thle OAA Festival Project 44%
Location Toronto / Downtown, Ontario
Clirmate Zone 5a
Project Type New Construction
Veartical Glazing / Wall Area 43%
Performance Sim Specs EnergyPlus 8.1.0.009 (EPW: CAN_ON_Toronto. 716240 _CWEC epw)
Conatruction Ste Owner/Agent Designer/Comtractor
666 Park AVe ima Driven Gerry Conway
Toronto, Ontario MaM aM4 CanbDo Developments Conway Architect Inc
666 Park Ave 185 Mafeking Ave
Toronto, Ontario MAM 4M4 Ottawa K1K2va
6136015689 6136015689
Ima . Driven@CanDo.ca ConwayArchitect@gmail.com
Building Area Floor Area
1-Gnd Fi. Retaill (Retail) : Norwresidential 10000
2-2nd - 10th (Office) : Nonresidential 90000
3-8smt. (Warehouse) .| Nonresidential 10000
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Thank you! Questions?

Ma
ma

tt Belcher, Verdatek Solutions
tt@verda-solutions.com

Cel

- (314) 749-4189

Corie Anderson, MEEA
canderson@mwalliance.org
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Upcoming Trainings

Online Commercial Energy Code Certificate Course through
Metropolitan Community College (MCC)

« 8-weeks, January 10-February 28, 2023

« Tuesdays 6p.m.-8p.m.

« $50 registration fee

« |CC and AIA CEUs provided

FREE Duct and Envelope Verifier Training and Train-the-Trainer in
Lincoln, NE. Become DET certified in 2 days or learn to train
others in 3 days! The course runs January 24-26, 2023, 9a.m.-
Sp.m.
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Poll: MCC Commercial Energy Code
Course

Online MCC Commercial Energy Code Certificate Course
. « 8-weeks, January 10-February 28, 2023

« Tuesdays 6-8p.m.
« $50 registration fee

g. » |CC and AlA CEUs provided
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